Interactive and Differential Pair Routing

Summary

Application Note

AP0135 (v1.7) May 21, 2008

Printed circuit board design was, and by some still is, referred to as “artwork”. It was called artwork because the design was created by placing black objects onto clear film, and these film layers were then used to fabricate the board, in a way that is analogous to how the printing industry transfers magazine ‘artwork’ to print.

Artwork is still a good name, not only because of how the design is transferred to fabrication, but also because there are artistic qualities to a well designed PCB. A well routed board will have the connections between the component pins flowing in neat patterns, moving around obstacles and between layers in an ordered, yet often creative way. Good routing requires the designer to have good three-dimensional spatial skills, a thorough and methodical approach, backed up by a sense of what gives routing style and quality.

Getting Ready to Route

Once the components are positioned on the board, you are ready to start routing. Before launching into Altium Designer’s routing features, let’s cover the features that will help you manage the routing process.

Is it Ready to Route?

There is a saying that PCB design is 90% placement and 10% routing. While you could argue about the percentage of each, it is generally accepted that good component placement is the most important aspect to good board design. Keep in mind that you may need to tune the placement as you route too, perhaps running a test autoroute on a dense area first, tweaking the placement to improve routability.

Prioritizing the Routing

Where to being, you ask? An autorouter typically routes connections one by one, whereas a human can consider the impact of many connections simultaneously. For the autorouter to have any hope it must do a good job of ordering the connections for routing. It will use factors such as connection length, density of connections, assignment of direction to routing layers, alignment of the connection direction to routing directions, and so on. And if it is any good, it will review the order constantly as it routes. A human will consider these factors as well, but will also use higher-order skills, such as will this set of 16 routes pass between those two components, should these noisy nets be routed on a separate pair of layers from these sensitive nets, and so on.

Finding that Net

An unrouted board can appear intimidating – a mass of connection lines criss-crossing all over the board. Controlling the display of the connection lines and setting their color will help you manage the routing process.

Using the PCB Panel

A valuable feature is the PCB Editor’s ability to mask, or filter objects in the workspace. This feature will fade out everything except the object(s) of interest. To explore this, set the mode of the PCB panel (upper dropdown list) to Nets, this will display a list of nets on the board. As you click on a net name in the panel the workspace display will change, zooming to show the nodes in the net, and fading out everything except the pads and connection lines in the net – effectively pulling out that net from the rest of the board. Note that even when you click in the workspace the mask remains, the chosen net remains clearly visible, making it easy to examine or route. Click the Clear button at the bottom right of the workspace to clear the mask and restore the entire workspace to normal brightness.

Note that as well as an individual net, you can mask a class of nets (if any classes are defined), and also multiple nets (by holding the CTRL key as you click in the PCB panel to select a net name).
**Interactive and Differential Pair Routing**

**Changing the Connection Line Color**

When the design is transferred from the schematic into the PCB workspace, a view configuration that controls the workspace environment and visibility of many elements is applied. View configurations are available for use in both 2D and 3D workspaces and are defined and edited in the *View Configurations* dialog (Design > Board Layers & Colors) and can be saved and re-used. An easy way to make important nets stand out is to change the color of their connection lines. To do this, double-click the net name in the PCB panel to open the *Edit Net* dialog, where you can edit the connection line color.

**Hiding/Displaying Connection Lines**

As an alternate to masking, you can completely hide one, many, or all of the connection lines. There are a number of commands to control the display of connection lines in the View > Connections submenu. You can also access these commands while you are working by pressing the N shortcut key.

**Are the Design Rules Defined?**

Before you start routing you need to configure the applicable routing design rules. Select Design > Rules from the menus to display the PCB Rules and Constraints Editor dialog. The tree on the left of the dialog shows the 10 rule categories (Electrical, down to Signal Integrity). In each category there are a number of rule types, for example, there are eight different types of routing rules you can define.

Selecting a rule type will display all the rules of that type that are currently defined. Figure 1 shows the four routing width rules defined for a board. Note rule priority, this defines the precedence of the rules, with 1 being the highest.

**The Rule Constraints**

Rule constraints specify the settings or limits you want applied to the objects targeted by this rule.

For the Width rule, constraints are for minimum, preferred and maximum widths of the track segments that make up the routing. Note that the min / preferred / max settings can also be defined for each of board layer, giving you complete control over how the board is routed. A handy feature to know is that you can increase and decrease the routing width as you route, between the minimum and maximum settings, read about this in the *Changing the Width During Interactive Routing* section.

**The Rule Scope**

Altium Designer has a powerful and flexible rule definition system, making it possible to exactly specify the design requirements, however complex they might be. Rather than defining routing requirements as attributes of the objects, design rules are defined separately, and then target the objects they apply to via the rule’s *scope* along the lines of ‘I want this rule to apply to those objects’.

It is this ability to exactly scope each rule, in combination with the ability to assign each rule’s priority that gives you complete control over the PCB design requirements.

Figure 2 shows the scope of a routing width design rule that is targeting the GND net. If the scope (Full Query) of the rule had been set to All, then it would apply to All nets on the board. Rules are scoped by writing a query. The query is written automatically if you select from the options on the left of the dialog, like All, Net, Net Class, and so on. If you are new to writing queries then try the Query Builder, it will walk you through the process and write the query for you.

---

**Figure 1.** Routing width rules defined for a board.

**Figure 2.** The scope of the rule is specified by entering a query that defines what objects this rule will target.

**Figure 3.** The rule constraints define the requirements of that rule. This rule specifies that the routing width must be between 0.2mm and 0.6mm.
For an overview of the query system read the Introduction to the Query Language article, or for more detail, read An Insiders Guide to the Query Language.

The Width Rule

The most basic routing rule is the Routing Width rule, which determines the width that the nets will be routed at. As a minimum, your design will have one width rule, targeting all nets on the board.

It is not good design practice to have only one width rule for a board, with the minimum width set to the smallest routing width you need on the board, and the maximum set to the widest route you need. A better approach is to have one rule that targets the largest number of nets, with a scope of All. You then add extra rules that target individual nets or classes of nets, such as the GND net, or the PowerNets net class (if such a class has been created). These rules will have a higher priority, so whenever you start to route one of these nets the higher priority rule will override the All nets rule, giving you the correct routing width. Suitable Width rules need to be defined before you start routing.

The Clearance Constraint

The partner to the width rule is the clearance constraint, which defines how close the net you are routing is allowed to get to other objects on that layer of the board. Again you can define multiple clearance constraints, to keep higher voltage nets or differential pair nets away from other routing, to keep polygon pours a specific distance from routing, and so on. Suitable Clearance Constraints need to be defined before you start routing.

For more information on design rules, refer to the article Specifying the PCB Design Rules and Resolving Violations, or for detailed information about each rule, refer to the Design Rules Reference.

Setting Up the Routing Layers

Routing layers, also referred to as signal layers, are set up in the Layer Stack Manager dialog (Design » Layer Stack Manager) shown in Figure 4. Use the dialog controls to add layers and set their location in the layer stack. The display of all layers, and the addition of mechanical layers, is controlled in the View Configurations dialog [shortcut L] shown in Figure 5.
Interactive and Differential Pair Routing

Interactive Routing

Interactive Routing is more than placing down track objects to join the dots (pads). Altium Designer supports fully featured interactive routing, available via Place » Interactive Routing in the main menu, the button on the PCB Standard toolbar, and the right-click menu. The Interactive Routing tools help maximize routing efficiency and flexibility in an intuitive way, including following cursor path for laying route sections, single-click connection routing, pushing or walking around obstacles, automatically following existing connections, etc, in accordance with applicable design rules.

When you start interactive routing, the PCB Editor will not only let you start placing track objects, it will:

• monitor cursor position and mouse-clicks, applying all applicable design rules
• follow your cursor path, minimizing the number of actions required to place sections of routing
• monitor the connectivity and update connection lines as soon as you finish a route
• supports routing-specific shortcuts, eg. pressing the * key to push to the next signal layer, inserting a via in accordance with the routing via style design rule.

Interactive routing tools are designed to be easy to use on-the-fly using the cursor and the keyboard shortcuts, so that all options are available when you need them - during the route. Seeing as there are a large number of shortcuts, the following sections will cover each interactive routing control/shortcut, grouped by its basic functionality.

Press the ~ (tilde) key while routing to display the available shortcuts (Figure 6). A complete list of interactive routing shortcuts is shown in Table 1.

An extension to interactive routing is Differential Pair Routing mode, where you route a pair of connections simultaneously.

The Basics - Placing Tracks

Once you enter Interactive Routing mode the cursor changes to a crosshair, waiting for you to click on a pad to begin routing from. Once you have clicked on the start location for the route, the current mode is shown on the Status bar (Figure 14) or in the Heads Up Display (HUD), if it is enabled. To place a track, move the cursor to where you want the current section of track segments to end and click or press ENTER - the track will be placed up to the current cursor position. Using your cursor path as a guidance system for the route provides you with high degrees of flexibility in controlling the path that the routing will take with the minimum number of actions required to commit the route (Figure 7).

Cursor guided routing makes complex manual routing around obstacles fast, easy and intuitive. In other words, you create the path of the route with your mouse and the Interactive Router attempts to place the tracks according to that path. This works in accordance with design rules and also with various constraints for track placement and corner types.

As you route, click to place the tracks up to the cursor then continue moving your cursor and so on. This is so that the software can accurately maintain the path you have chosen - if you go too far before committing the tracks, it is possible that portions of your path will be altered.

Note: In free-space (no obstacles to route around), routing will generally be placed to minimize length. If you want to accurately control the route in free-space, you must click to place the tracks where you want them to stay.
If you need to change the path of the route, you can reverse the path of the cursor back over itself and any uncommitted tracks will be removed. Be sure to follow the original path fairly closely so that the software can recognize that you are undoing the path and not adding to it. To reverse back over committed paths, you need to use the BACKSPACE key to progressively reverse committed sections back to the previous committed section. If you have committed the path right up to the target, path reversal is not available.

The following basic keyboard shortcuts can be used at any time:

- **ENTER** or Left-click Mouse - Commits the routing up to the current cursor position and places the tracks.
- **ESC** - Terminate the current route. Any routing that has been committed before calling the termination is retained.
- **BACKSPACE** - Unwinds the last committed route back to its starting point. If any objects had been pushed through placing the last segment, they are moved back to their original positions. This feature is not available after using **Auto-Complete**.
- **7** - Cycles through the connections available for routing if the current pad has multiple connections.
- **9** - Switches the cursor position from the currently selected pad or track to the target pad or track. If the location of the object being switched to is not in the current window, the view jumps and centers around the new cursor position.

**Placing Tracks and Looking Ahead**

There are two modes for committing tracks in relation to the cursor position. That is, up to which point the tracks be laid upon commit (click). When this mode is enabled, tracks will be placed, but not including the last segment (one segment placement). When this mode is disabled, the tracks will be placed right up to the current cursor position (two segment placement).

Use the **1** shortcut key to toggle the mode on-the-fly (Figure 8).

**Controlling Corner Styles**

Multiple styles are available for controlling the changes of direction of the route (Figure 9). The styles are always available and can be cycled through using **SHIFT + SPACEBAR**. Note: If the **Restrict to 90/45** option is enabled in the **PCB Editor - Interactive Routing** page of the **Preferences** dialog, the radiused and any angle corner options are unavailable.

Corner styles available are:

- Any angle (A)
- 45° (B)
- 45° with arc (C)
- 90° (D)
- 90° with arc (E).

Arrows can be increased or decreased in radius (known as "setback") using . (period or full stop) and , (comma) respectively. **SHIFT + ,** and **SHIFT + .**, increase/decrease setback by a factor of 10.

Use **SPACEBAR** to toggle the direction of the corner.

The Interactive Router has many features that control how the tracks are laid and what to do when encountering other objects on the board. The following sections cover these functions.

**Automatic Connection Completion**

The Interactive Router is able to attempt automatic completion (Auto-Complete) of connections to the target pad using **CTRL + Click**. This can make routing much faster, than placing individual track segments, however, there are some limitations to Auto-Complete feature, as follows:

- Start point and target pad are on the same layer
- The route can be completed in accordance with design rules (provided that routing conflicts are not being ignored).

Auto-Complete is available at any time, and you can even **CTRL + Click** directly on a pad or connection line to route it - no need to select it first. You can use Auto-Complete on connections that are partially routed as well. To do this, **CTRL + Click** on the end of the last track segment or the remaining connection line to complete it to the target.

If a connection using Auto-Complete cannot be made, the tool will return to the last used interactive routing mode.
Interactive and Differential Pair Routing

Handling Routing Conflicts
Routing is a juggling process - placing tracks amongst the existing component pads, tracks and vias. Altium Designer has different methods of dealing with conflicts created between your new route and existing objects encountered during interactive routing. These tools help make routing as painless and as quick as possible whilst, at the same time, maintaining routing elegance and consistency.

Any method of conflict resolution can be called at any time during routing. Cycle through and select the desired mode using \texttt{SHIFT + R}.

During interactive routing, if you attempt to route into an area that cannot be resolved using Push or Hug & Push modes, an indicator appears at the end of the permissible tracks so you know immediately that you are blocked. This is shown in Figure 10.

Walking Around Obstacles
This mode will attempt to follow your cursor and find a routing path around existing obstacles (Figure 11).

Walkaround mode is supported by features that provide control over how the new tracks are placed in relation to the objects that they are 'walking around' - these are referred to as Hug modes. There are two Hug modes:

- Minimize Length - attempts to bypass existing objects whilst keeping the new routing as short as possible.
- Maximize Hugging - attempts to trace around existing objects as closely as possible.

The way that either Hug mode places tracks on corners is dependent on the corner style being used.

Toggle Hug modes using \texttt{SHIFT + H}.

If conflicting objects cannot be traced around to accommodate the new routing without causing violations, the routing will be automatically clipped at the nearest conflicting object.

Pushing Obstacles
This mode is also known as push 'n' shove. It will follow your cursor and attempt to move objects (tracks and vias), which are capable of being repositioned without violation, to accommodate the new routing (Figure 12).

If conflicting objects cannot be moved enough to accommodate the new routing without causing violations, the routing will be automatically clipped at the nearest conflicting object and the blockage indicator shown.

Hugging then Pushing Obstacles
This mode is a combination of Walkaround and Push functionality. It will follow your cursor and walkaround obstacles, however, will also take on Push mode functionality when the tracks you are placing violate against fixed obstacles. Fixed obstacles typically being pads, but also any locked objects, such as tracks and vias.

If conflicting objects cannot be walked around or moved enough to accommodate the new routing without causing violations, the routing will be automatically clipped at the nearest conflicting object and the blockage indicator shown (Figure 10).
Ignoring Obstacles
This mode makes no attempt to avoid routing conflicts as it follows your cursor. Rule violations are highlighted as you route, but you are free to route wherever you want (Figure 13).

Conflict Resolution Settings
The Routing Conflict Resolution settings used when you first start routing are configured in the PCB Editor – Interactive Routing page of the Preferences dialog (Tools » Preferences), shown in Figure 14. These settings in this dialog will reflect the modes and options that were last used during interactive routing.

These same settings can also be accessed from the Interactive Routing for Net dialog (Figure 23), which can be opened by pressing TAB during interactive routing. Whenever these settings are changed (in either dialog or through the shortcut menu system), they become the initial settings when the Interactive Routing command is next called.

The Status bar shows you the current routing mode being used (as does the Heads Up Display (HUD), when it is enabled). You can toggle the HUD information using the Summary option in the PCB Editor - Board Insight Modes page of the Preferences dialog.

Adding Vias and Switching Layers During Routing
Altium Designer provides you with ability to add vias on-the-fly during interactive routing. Vias can be added in only valid locations, that is, the software will prevent you from placing vias if they conflict with objects on any of the layers (this does not apply if the conflict resolution mode is set to Ignore).

The properties of the via are determined by the applicable Routing Via Style design rule in the PCB Rules and Constraints Editor dialog (Design » Rules).

Adding a Via On Layer Change
Press the * (asterisk) or + (plus) key on the numeric keypad while routing to insert a via and switch the routing to the next signal layer. Press the - (minus) key on the numeric keypad to insert a via and switch the routing to the previous signal layer. These commands follow the Routing Layers design rule, meaning that it will only switch to layers that are allowed to be routed on. Click to commit the via position and continue routing.

Adding a Via Without Layer Change
Press the 2 key while routing to insert a via, however, keep routing on the current signal layer. Click to commit the via position.

Adding Fanout Vias
Press the / key while routing to insert a via for the current route, click to commit the via position, with the tool returning to its previous interactive routing mode, enabling you to immediately begin routing another connection. This function can save time when there are many vias to place, as in a typical fanout.
Interactive and Differential Pair Routing

Switching Layers for Current Route
When you are routing from a multi-layer pad or via, you can use L at any time to switch the layer for the current connection to the next signal layer defined for that pad/via. This is useful during routing when you discover a conflict situation that requires a layer change.

Figure 15 shows the initial routing attempt on the top layer with no way to reach the target on the left. Pressing L immediately relocates the routing on the next signal layer (bottom layer in this case) as shown on the left, making the connection possible.

Length Tuning Connections while Interactive Routing
In cases where you need to accurately control connection length for special purposes, such as signal timing, Altium Designer provides intuitive controls to speed up track placement and make short work of reaching optimum lengths, during the route. The target length can be set manually, from the Length design rule (Figure 16), or from the length of an existing routed net.

Length tuning in Altium Designer takes the form of extra track segments added to the track (in waveform patterns) in order to reach the desired overall length. These are known as accordion sections.

Enter Length Tuning mode using SHIFT + A whilst you are interactively routing. Once entered, this mode will begin placing accordion sections as you move the cursor along the route. You can specify length tuning options, such as target length, amplitude and accordion styles, etc. in the Interactive Length Tuning dialog (Figure 17). Press TAB when length tuning to open this dialog.

During the length tune, use SHIFT + G to display the Length Tuning Gauge (Figure 18). This tool provides an easy to understand visual display that shows how close the net length is getting to the target length. It shows you the current length (at bottom-left), desired length (top-right) and tolerance (between center bar and right-hand bar). If the color of the bar turns red, it indicates that the length is over the upper limit of the set tolerance.

Once you have length tuned the required nets, it is advisable that you lock them so that any other routing in Push mode does not alter the length. To lock a net, select Edit » Select » Net, click the net, press F11 to open the PCBList panel and enable the Locked option.

Figure 15. SHIFT + C switches the signal layer for the current routing.

Figure 16. Length design rules are ideal for setting a net length tolerance.

Figure 17. Pressing TAB while length tuning will bring up the Interactive Length Tuning dialog.

Figure 18. The Length Tuning Gauge makes it easy to see how close you are to reaching the target length.
Interactive and Differential Pair Routing

Changing Track Width while Interactive Routing

Altium Designer's offers extensive features for adjusting track width during the routing process.

Setting the Constraints

The rules define the limits that are acceptable in your design. Typically there is a range to these limits, for example, you might want signal tracks to be 0.2mm wide (≈ 8mil), but your board fabricator will handle a small amount of tracks down to 0.13mm (≈ 5mil), at no extra cost. Or your power fanout tracks are typically routed at 0.4mm, but you can accept them down to 0.2mm if necessary, and will always make them wider wherever it is possible.

The Routing Width design rule includes a preferred setting, use this if you want a preferred starting width that is somewhere between the minimum and maximum widths.

You configure which width should be used when you start interactive routing in the PCB Editor – Interactive Routing page of the Preferences dialog, as shown in Figure 19.

Freedom Within the Defined Constraints

Sure you say, the minimum and maximum settings define the boundaries, and the preferred setting is handy, but I need greater choice over what width I use in a given situation.

Altium Designer can give you this – the safety of the rule boundaries, with complete flexibility to choose a width between them. Read on to learn about the three ways you can select a different routing width while you are routing.

Pick the Width from Pre-defined Favorites

Press the SHIFT+W shortcut while you are routing to pop up a palette of pre-defined widths, and click to select the width you want, either metric or imperial.

You still have the full protection of the rules system, if the number you click on is outside the min-max rule setting the width you will be clipped back to the minimum or maximum, whichever is appropriate.

Figure 20 shows the Choose Width dialog that appears when you press SHIFT+W as you route. Right-click in the dialog to hide/display the different columns.

Use the Apply To All Layers option to set the current routing width in all of your signal layers.

Favorite widths can be configured using the Favorite Interactive Routing Widths dialog (Figure 21) available from the Favorite Interactive Routing Widths button in the PCB Editor – Interactive Routing page of the Preferences dialog, or use the Favorite Routing Widths menu item in the Options popup menu [shortcut: O].

Note the shading in the dialog. Entries without shading indicates the preferred units of this entry, the board units will be switched automatically when the entry is chosen.

To enter a new preferred width click the Add button. If you include the units (either or mm or mil) then you can control the units you want used for that entry.

Using Pre-defined Widths as you Route

Figure 19 shows the Track Width Mode where you are able to specify the minimum, preferred or maximum rule width when you start to route as well as a User Choice option.

When you use the SHIFT+W shortcut to change the width, Altium Designer will switch the Track Width Mode to User Choice, and save the setting you choose as a property of that net. The width you choose is saved as the Current Interactive Routing Settings properties of the net, which you can see in the Edit Net dialog (Figure 22).

Right-click a net object and select Properties from the Net Actions sub-menu to open the Edit Net dialog. Alternatively, double-click the net name in the PCB panel to open the dialog. You can define settings in advance, and changes you make during routing are saved here.

Figure 19. Specify which width should be used when you start routing a net.

Figure 20. Select from the pre-defined routing widths by pressing SHIFT+W during routing.

Figure 21. Use the Favorite Interactive Routing Widths dialog to add and remove your favorites.. These are saved with system preferences.
Again, you still have the full protection of the rules system, if the value you have defined in the Edit Net dialog is outside the min-max rule setting the width you get will be clipped back to the minimum or maximum defined in the applicable rule, whichever is appropriate.

**Entering a Width that is Not Pre-defined**

For the ultimate level of control, you can enter a specific width while you are routing. Altium Designer’s generic edit on-the-fly feature is available during schematic or PCB object placement. Pressing TAB will open the Interactive Routing for Net dialog, as shown in Figure 23.

Here you can enter an exact track width or via size. You can also check the current Interactive Routing settings, rather than having to drop out of routing and open the Preferences dialog.

The value you enter in the Interactive Routing for Net dialog is saved as your user choice for that net, opening the Edit Net dialog for that net will confirm this.

**Picking Up the Existing Track Width**

Figure 19 shows the routing width you will be given when you start to route. Note the Pickup Track Width from Existing Routes option – this feature is invaluable if you do use a variety of widths, with it on, you will automatically be given the width of the existing routing that you are starting from.

To temporarily inhibit the pickup behavior hold the SHIFT key as you click to start routing. To pickup a width from an existing track on the board, start routing, then move the cursor over the track, and press the INSERT key. Current layer objects have higher priority. Using any of these options will set the user choice value (in the Edit Net dialog) and switch the Track Width Mode to User Choice.

**Keeping Track of your Status**

During interactive routing keep an eye on the status bar, it will let you know what interactive routing width mode you are currently in as well as providing detailed feedback on the net, including the current routed net length. This information is also displayed in the Heads Up Display (HUD), if it is enabled (Figure 24).
Interactive and Differential Pair Routing

Modifying Existing Routing

Routing is probably the most iterative process you perform designing a board, constantly defining and re-defining connection paths as the board layout evolves. This iterative nature requires routing modification tools that complement the interactive routing tools. Altium Designer includes features that allow you to modify existing routing with either your re-router’s hat on – let me redefine that routing path, or your drafter’s hat on – let me move that set of tracks over to free another routing channel.

The re-router is supported by a feature called Loop Removal. The drafter is supported by sophisticated dragging capabilities, which are actually useful for both modifying existing routing, and creating new routing – but more on that later.

Rerouting an Existing Route – Loop Removal

As you route there will be many instances where you need to change some of the existing routing. Rather than attempting to change the existing routing using a drafting type approach of clicking and dragging track segments, you re-route. To do this you select one of the Interactive Routing commands from the Place menu, click on the existing routing to start and then route the new path, coming back to meet the existing routing. This will create a loop with the old path and the new path, no need to worry though, as soon as you press ESC to terminate the route the redundant segments are automatically removed, including any redundant vias. This feature is known as Loop Removal.

Protecting an Existing Route

There are times when this loop removal behavior works against you though, for example, when you are routing a power net. You can disable Loop Removal selectively for any net, double click on the net name in the PCB panel and clear the Remove Loops option in the Edit Net dialog.

Multi-track Dragging with Angle Preservation

Re-routing is not always the best approach to modifying routing, for example, situations where you want to move a track segment slightly, keeping the neat 45° and 90° corners at either end. Altium Designer supports this, through multi-track dragging with angle preservation. Dragging behavior is controlled by the Preserve Angle When Dragging option in the PCB Editor - Interactive Routing page of the Preferences dialog.

To drag, click once on the segment to select it – the cursor will change to a quad-arrow – then click and drag to slide it to a new location. You will notice that the angles to adjacent track segments are preserved, maintaining the routing style.

By selecting first, you indicate that you want segments connected at either end to remain connected. Alternatively, use the CTRL + Left-click + Drag to drag without having to select first. Multiple selected track segments can also be dragged, as long as they share the same orientation and are not part of the same connected copper.

Like the interactive routing modes, you can use the SHIFT + R shortcuts to cycle through options that control how obstacles should be handled during dragging (Ignore Obstacle, Avoid Obstacle or Avoid Obstacle (snap grid)). If one of the Avoid Obstacle modes is enabled, the rules will be obeyed during dragging, preventing you from dragging a segment into violation. It also supports pad/via hopping, allowing you to drag a walk-around from one side of a pad or via to the other side.

Dragging on a track end will add a segment to preserve the routing quality, hold the ALT key before dragging to move the end of the segment.

Figure 25. Re-routing an existing route, using Push. The old loop is automatically removed.

Note the special drag cursor. Selected segments are dragged.

Selected segments dragged to new location.

To drag with angle preservation you need to select first. There are several selection techniques. Press the S shortcut to pop up the Selection submenu, where you will find Touching Line and Touching Rectangle.
Using Smart Drag for Multi-trace Routing

The ability to drag multiple track segments can be used for more than just modifying existing routes, it can also be used to form new routing.

It utilizes a simple, yet elegant feature for extending unconnected track ends. Clicking and dragging on the end vertex of a dangling track segment does more than extend that segment.

As well as extending the current segment, new segments are automatically added, connected at 45° to the current track segments. This, in effect, gives the ability to extend existing routing.

This system also supports selecting a group of tracks and extending them, as a single entity.

To extend the routing on a set of track segments, select the segments and then click and drag on the end vertex of one of the selected segments. New segments will automatically be added as you move the mouse, when you release these segments will be selected. You can then continue to click and drag to add new segments to the end of all selected segments, as shown in Figure 26.

As well as clicking on the end vertex of a selected segment and dragging, you can also use the Place » Multiple Traces command to extend selected routing.

Place and Gather Multiple Traces

Complimenting the smart drag’s multi-track placement capabilities is the Place » Multiple Traces command. Using this command you can start with an unrouted component and effectively pull the routing out of the selected component pads. The multiple traces are then automatically gathered together, as shown in Figure 27.

The command is launched from the Place menu, press the P shortcut key to pop it up.

Keep the following tips in mind when working with the Place » Multiple Traces command:

- Rather than selecting component pads one by one, hold the CTRL key as you click and drag a rectangle to select. Holding CTRL limits the selection to the pad objects only, rather than selecting the parent component. This also works with the Touching Line and Touching Rectangle commands.
- Press the TAB key to open the Bus Routing dialog, where you set the Bus Spacing (track center to center separation).
- Alternatively, use the , (comma) and . (full stop) shortcuts to interactively decrement and increment the bus spacing, in steps of the current snap grid.
- Press the SPACEBAR to change the end alignment (once the first set of segments have been placed).
- Press the ~ (tilde) key for a list of interactive shortcuts.
Interactive and Differential Pair Routing

Differential Pair Routing

Background

A differential signaling system is one where a signal is transmitted down a pair of tightly coupled carriers, one of these carrying the signal, the other carrying an equal but opposite image of the signal. Differential signaling was developed to cater for situations where the logic reference ground of the signal source could not be well connected to the logic reference ground of the load. Differential signaling is inherently immune to common mode electrical noise, the most common interference artifact present in an electronic product. Another major advantage of differential signaling is that it minimizes electromagnetic interference (EMI) generated from the signal pair.

Differential pair routing is a design technique employed to create a balanced transmission system able to carry differential (equal and opposite) signals across a printed circuit board. Typically this differential routing will interface to an external differential transmission system, such as a connector and cable.

It is important to note that while the coupling ratio achieved in a twisted pair differential cable may be better than 99%, the coupling achieved in differential pair routing will typically be less than 50%. Current expert opinion is that the PCB routing task is not to try and ensure a specific differential impedance is achieved, rather the objective is to maintain the properties required to ensure the differential signal arrives in good condition at the target component as it travels from the external cabling.

According to Lee Ritchey, a noted industry high-speed PCB design expert, successful differential signaling does not require working to a specific differential impedance. What it does require is:

- To set each of the routing signal impedances to half the incoming differential cable impedance.
- That each of the two signal lines is properly terminated in its own characteristic impedance at the receiver end.
- That the two lines should be of equal length, to within tolerances of the logic family. Typically a length difference of up to 500mil is acceptable.
- Use the benefit of routing the two signals side-by-side to help achieve good quality routing of matched lengths, where required it is acceptable to separate to route around obstacles.
- Layer changes are acceptable, as long as the signal impedances are maintained.


Defining the Differential Pairs on the Schematic

Differential pairs are defined on the schematic by placing a differential pair directive (Place » Directive) on each of the nets in the pair. The net pair must be named with net label suffixes of _N and _P. Placing a differential pair directive on each pair net applies a parameter to the net, which has a parameter Name of DifferentialPair and a Value of True.

Differential pair definitions are transferred to the PCB during design synchronization.

Defining Differential Pairs on the PCB

Differential pairs should be defined on the schematic, however, differential pair objects can be defined in the PCB Editor.

To create a differential pair object, select Differential Pairs Editor mode in the PCB panel and click the Add button. From the resulting Differential Pair dialog (Figure 28), select existing nets for both the positive and negative nets, give the pair a name and click OK.

You can also create a differential pair objects using net names conforming to a naming convention with a common prefix, followed by a consistent positive/negative suffix, for example, TX0_P and TX0_N. To do this, click the Create From Nets button in the PCB editor panel (Figure 30) to open the Create Differential Pairs From Nets dialog. Use the filters at the top of the dialog.
Interactive and Differential Pair Routing

to show net pairs, based on existing net names. Figure 31 shows the dialog displaying the list of differential pair nets on the board that end with the letters _P and _N.

Figure 31. Quickly create pairs for the entire board, based on logical net naming.

Viewing and Managing Differential Pairs

Differential pair definitions are viewed and managed in the PCB panel, set to Differential Pairs Editor. Figure 30 shows the pairs that belong to the All Differential Pairs class. Pair V_RX0 is highlighted, the nets in this pair are V_RX0_N and V_RX0_P. The (-) and (+) displayed next to each member net name is a system flag, indicating if it is the positive or negative member of the pair.

Applicable Design Rules

There are three design rules you will need to configure in the PCB Rules and Constraints Editor dialog (Design » Rules) to route a differential pair. These are:

- **Routing Width** – defines the routing width required for both nets in the pair and can be based on either physical track widths you define or be automatically calculated based on characteristic impedance values you define. Set the scope of this rule to target objects that are members of a differential pair, eg. InDifferentialPair.

- **Differential Pairs Routing** – defines the separation between the nets in the pair, the gap allowed, and the overall uncoupled length (the pair is uncoupled when the gap is wider than the Max Gap setting). Set the scope of this rule to target objects that are a differential pair, eg. IsDifferentialPair.

- **Electrical Clearance** – defines the minimum clearance between any two primitive objects (e.g. pad-pad, track-pad) on either any net, the same net or between different nets. Set the scope of this rule to target objects that are members of a differential pair, eg. InDifferentialPair.

The lengths of the differential pairs can be tuned accurately using the Interactive Diff Pair Length Tuning feature (from Tools menu). When using this feature you have full on-the-fly control over target length and tolerance, and have various options to increase differential pair net lengths by adding variable amplitude wave patterns to the net pairs.

Setting the Scope of the Design Rules

The scope of the design rule defines the set of objects that you want the rule to applied to. Since a differential pair is an object, you can use queries like the following examples to scope the rule to target differential pairs:

- **InDifferentialPairClass(’All Differential Pairs’)** – targets all nets in all pairs belonging to the differential pair class called All Differential Pairs.

- **InDifferentialPair(’D_V_TX1’)** – targets both nets in the differential pair named D_V_TX1.

- **(IsDifferentialPair And (Name = ’D_V_TX1’))** – targets the differential pair object that has a name of D_V_TX1.

- **(IsDifferentialPairAnd (Name Like ’D*’))** – targets all differential pair objects whose name starts with the letter D.

Using the Differential Pair Wizard to Define the Rules

Click the Rule Wizard button in the Differential Pairs Editor (PCB panel) to walk you through the process of setting the required design rules. Note that the scope used for the created rules will depend on what was selected when the Rule Wizard button was clicked – if one pair was selected the rules will target the nets in that pair, but if a differential pair class was selected then the rules will target the nets and all pairs in that class.
Routing a Differential Pair

Differential pairs are routed as a pair – that is, you route two nets simultaneously. To route a differential pair, select Place » Differential Pair Routing in the main menu, the [button on the PCB Standard toolbar, and the right-click menu. You will be prompted to select one of the nets in the pair, click on either to start routing. Figure 32 shows a differential pair being routed. To make the connection lines for the pair easier to see, click on the pair in the Differential Pairs Editor (PCB panel). This will mask all other nets in the design.

Differential pairs are routed using an interactive routing mode that either stops at the first obstacle or ignores them. Use SHIFT + R to cycle the modes. Some similar routing shortcuts to Interactive Routing modes remain, such as pressing the * key on the numeric keypad to switch to the next routing layer. A complete list if Interactive Differential Pair routing shortcuts is shown in Table 2.

Press the ~ (tilde) key while routing to display the available shortcuts.

Full Differential Pair Support for FPGA Designs, Including Pin Swapping

Modern FPGAs, even low cost types, can have a large number of I/O pins that can be configured as differential pairs. To make it easy to harness the power of these, Altium Designer includes full support for integration of FPGA-based differential pairs, in both FPGA and PCB design.

In your FPGA design you can assign a single net to a differential I/O standard, such as LVDS, and this will be mapped to a pair of physical nets at the PCB design level. This process is under your control using the FPGA Signal Manager.

The design compiler can also determine if the pins used as differential pairs at the PCB design level map correctly to the allowable pairs on an FPGA device.

Signal Integrity Support for Differential Pairs

Altium Designer’s Signal Integrity analyzer provides full support for the simulation of differential pairs. This uses the correct signal integrity model for pins when using the LVDS standard with FPGAs.
Optimizing and Controlling Net and Differential Pair Lengths

Tuning and matching route lengths is a standard technique for maintaining data integrity in a high-speed digital system, and an essential ingredient of differential pair routing. Interactive Length Tuning and Interactive Diff Pair Length Tuning features (launched from the Tools menu) allow a dynamic means of optimizing and controlling net or differential pair lengths by allowing variable amplitude wave patterns to be inserted according to the available space, rules, and obstacles in your design. Length tuning properties can be based on design rules, properties of the net, or values you specify. Controls for these wave patterns, also known as accordion sections, are accessed through the Interactive Length Tuning dialog (press TAB to open the dialog whilst interactively length tuning).

Once you have launched the command, click on the routed net or differential pair and move the mouse along it to add accordion sections. The Length Tuning Gauge (Figure 34), which appears once you start length tuning, provides information during the tuning process including before and current track lengths as well as a graphical representation that indicates how close you are to the ideal length. The yellow lines indicate the possible minimum and maximum lengths. The green line indicates the target length, as determined from the applicable Matched Length and Length design rules (Figure 35, or the settings in the Interactive Length Tuning dialog (Figure 33). The colored bar shows how close you are to achieving the required length. If the color of the bar turns red, it indicates that the length is over the upper limit of the set tolerance.

The interactive length tuning tools can be configured for:

- **Target Length** - can be specified either according to design rules, another net, or manually. The Clip to target length option will precisely clip mitered wave patterns to the target length.
- **Pattern** - wave styles are mitered with lines, mitered with arcs, and rounded. You have control over amplitude, gap and dynamic amplitude increments. It is possible to have more than one pattern on a net.

While interactively length tuning you can vary any aspect of the length tuning parameters using key combinations. Press the ~ (tilde) key during length tuning to display the available shortcuts, or see Table 3 in this document.

Once you have length tuned the required nets, it is advisable that you lock them so that any other routing in Push mode does not alter the length. To lock a net, select Edit » Select » Net, click the net, press F11 to open the PCB Inspector panel and enable the Locked option.
Automated Fanout and Escape Routing

Altium Designer has excellent surface mount component fanout tools. These also support BGA escape routing. The escape routing engine will attempt to route each pad out to just beyond the edge of the device – making routing connections to them much easier.

Figure 36. Note how the escape route feature presents each connected pad as an accessible route outside the edge of the BGA.

Figure 36 shows the escape routing from a 1mm pad pitch BGA. Used inner pads are first fanned out using the traditional dog-bone (a short route with a via on the end) to access another layer, and then from the via they are escape routed out just beyond the edge of the device, working through the available routing layers until all pads have been escape routed.

Right-click on a BGA and select Component Actions » Fanout Component from the right-click menu. The routing will be done in accordance with the applicable design rules. A report of all pads that could not be escape routed will be generated and opened, click on an entry in the report to cross probe to the PCB and examine that object.

The Fanout Options dialog (Figure 37) has controls that let you specify fanout and escape routing options as well as options for using blind vias (between drill pair layers, which are set up in the Layer Stack Manager dialog [shortcut: D, K]). Other options include fanning out the outer two rows of pads in addition to the inner (and harder to get to) rows and only pads that have nets assigned to them.

Figure 37. Use the Fanout Options dialog to control automated component fanning out.
## Interactive Routing Shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ (tilde)</td>
<td>Display list of shortcuts</td>
</tr>
<tr>
<td>F1</td>
<td>Display graphical hotkey list help</td>
</tr>
<tr>
<td>CTRL + Click</td>
<td>Auto-Complete segments to target</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>Remove last committed segment(s)</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel route at current trace</td>
</tr>
<tr>
<td>SHIFT + A</td>
<td>Add accordion sections (interactive length tuning)</td>
</tr>
<tr>
<td>SHIFT + G</td>
<td>Toggle length tuning gauge</td>
</tr>
<tr>
<td>SHIFT + H</td>
<td>Toggle Hug setting for Walkaround mode</td>
</tr>
<tr>
<td>L</td>
<td>Switch layer for the current trace to the next signal layer</td>
</tr>
<tr>
<td>SHIFT + R</td>
<td>Toggle Interactive Routing mode</td>
</tr>
<tr>
<td>SHIFT + V</td>
<td>Select favorite via size via Choose Via Sizes dialog</td>
</tr>
<tr>
<td>SHIFT + W</td>
<td>Select favorite width via Choose Favorite Width dialog.</td>
</tr>
<tr>
<td>. (comma)</td>
<td>Decrease arc setback (radius)</td>
</tr>
<tr>
<td>. (comma)</td>
<td>Decrease arc setback (radius) 10x</td>
</tr>
<tr>
<td>. (full stop / period)</td>
<td>Increase arc setback (radius)</td>
</tr>
<tr>
<td>. (full stop / period)</td>
<td>Increase arc setback (radius) 10x</td>
</tr>
<tr>
<td>ENTER</td>
<td>Commit and place track segments up to current cursor position</td>
</tr>
<tr>
<td>/</td>
<td>Add fanout via, and immediately reset tool to wait for next route</td>
</tr>
<tr>
<td>+ (plus)</td>
<td>Next signal layer (numeric keypad)</td>
</tr>
<tr>
<td>- (minus)</td>
<td>Previous layer (numeric keypad)</td>
</tr>
<tr>
<td>* (multiply)</td>
<td>Next signal layer (numeric keypad)</td>
</tr>
<tr>
<td>SPACEBAR</td>
<td>Cycle corner direction</td>
</tr>
<tr>
<td>SHIFT + SPACEBAR</td>
<td>Cycle corner styles (if restrict to 90/45° is disabled)</td>
</tr>
<tr>
<td>TAB</td>
<td>Edit trace or length tuning properties via associated dialog</td>
</tr>
<tr>
<td>1</td>
<td>Toggle Look-ahead mode – switches between 1 and 2 segment placement mode</td>
</tr>
<tr>
<td>2</td>
<td>Add via, no layer change</td>
</tr>
<tr>
<td>3</td>
<td>Cycle track width source</td>
</tr>
<tr>
<td>4</td>
<td>Cycle via size source</td>
</tr>
<tr>
<td>7</td>
<td>Switch leader trace or switch routing target in single trace mode</td>
</tr>
<tr>
<td>9</td>
<td>Switches to opposite routing point</td>
</tr>
</tbody>
</table>

Table 1. Interactive Routing shortcut keys.
## Interactive Differential Pair Routing Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ (tilde)</td>
<td>Display list of shortcuts</td>
</tr>
<tr>
<td>CTRL + Click</td>
<td>Commit Auto-Complete segments (if applicable)</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>Remove last segment</td>
</tr>
<tr>
<td>SHIFT + BACKSPACE</td>
<td>Remove last cluster of segments</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel route at current trace</td>
</tr>
<tr>
<td>SHIFT + R</td>
<td>Toggle routing mode</td>
</tr>
<tr>
<td>SHIFT + W</td>
<td>Open <em>Choose Favorite Width</em> dialog.</td>
</tr>
<tr>
<td>ENTER</td>
<td>Place segment</td>
</tr>
<tr>
<td>+ (plus)</td>
<td>Next layer</td>
</tr>
<tr>
<td>- (minus)</td>
<td>Previous layer</td>
</tr>
<tr>
<td>* (multiply)</td>
<td>Next signal layer</td>
</tr>
<tr>
<td>SPACEBAR</td>
<td>Toggle corner direction</td>
</tr>
<tr>
<td>SHIFT + SPACEBAR</td>
<td>Cycle corner styles (if restrict to 90/45° is not enabled)</td>
</tr>
<tr>
<td>TAB</td>
<td>Edit trace properties</td>
</tr>
<tr>
<td>3</td>
<td>Cycle track width source</td>
</tr>
<tr>
<td>4</td>
<td>Cycle via size source</td>
</tr>
<tr>
<td>5</td>
<td>Toggle Auto-complete</td>
</tr>
<tr>
<td>6</td>
<td>Change via mode</td>
</tr>
<tr>
<td>7</td>
<td>Switch leader trace (diff pair) or switch routing target</td>
</tr>
</tbody>
</table>

*Table 2. Interactive Differential Pair Routing shortcut keys.*

## Interactive Length Tuning Shortcuts

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~ (tilde)</td>
<td>Display list of shortcuts</td>
</tr>
<tr>
<td>TAB</td>
<td>Edit tuning pattern settings via <em>Interactive Length Tuning</em> dialog</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>Remove last segment</td>
</tr>
<tr>
<td>SPACEBAR</td>
<td>Next tuning pattern</td>
</tr>
<tr>
<td>SHIFT + SPACEBAR</td>
<td>Previous tuning pattern</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Decrease pattern amplitude by one increment</td>
</tr>
<tr>
<td>. (full stop / period)</td>
<td>Increase pattern amplitude by one increment</td>
</tr>
<tr>
<td>1</td>
<td>Decrease miter or radius</td>
</tr>
<tr>
<td>2</td>
<td>Increase miter or radius</td>
</tr>
<tr>
<td>3</td>
<td>Decrease pattern gap by increment</td>
</tr>
<tr>
<td>4</td>
<td>Increase pattern gap by increment</td>
</tr>
<tr>
<td>Y</td>
<td>Toggle amplitude direction</td>
</tr>
</tbody>
</table>

*Table 3. Interactive Length Tuning shortcut keys.*
Interactive and Differential Pair Routing

Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version No.</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-Dec-2005</td>
<td>1.0</td>
<td>New release</td>
</tr>
<tr>
<td>16-Dec-2005</td>
<td>1.1</td>
<td>New interactive routing detail added</td>
</tr>
<tr>
<td>19-Jun-2006</td>
<td>1.2</td>
<td>New multi-track smart dragging detail added</td>
</tr>
<tr>
<td>17-Apr-2007</td>
<td>1.3</td>
<td>Updated for Altium Designer 6.7</td>
</tr>
<tr>
<td>15-Oct-2007</td>
<td>1.4</td>
<td>Updated for Altium Designer 6.8</td>
</tr>
<tr>
<td>7-Jan-2008</td>
<td>1.5</td>
<td>View configuration info updated. Dialog box units toggle images added 6.9.</td>
</tr>
<tr>
<td>28-Feb-2008</td>
<td>1.6</td>
<td>Converted to A4</td>
</tr>
<tr>
<td>21-May-2008</td>
<td>1.7</td>
<td>Updated with new interactive routing, fanout features for Summer 08 release.</td>
</tr>
</tbody>
</table>

Software, hardware, documentation and related materials:

Copyright © 2008 Altium Limited. All Rights Reserved.

The material provided with this notice is subject to various forms of national and international intellectual property protection, including but not limited to copyright protection. You have been granted a non-exclusive license to use such material for the purposes stated in the end-user license agreement governing its use. In no event shall you reverse engineer, decompile, duplicate, distribute, create derivative works from or in any way exploit the material licensed to you except as expressly permitted by the governing agreement. Failure to abide by such restrictions may result in severe civil and criminal penalties, including but not limited to fines and imprisonment. Provided, however, that you are permitted to make one archival copy of said materials for back up purposes only, which archival copy may be accessed and used only in the event that the original copy of the materials is inoperable. Altium, Altium Designer, Board Insight, DXP, Innovation Station, LiveDesign, NanoBoard, NanoTalk, OpenBus, P-CAD, SimCode, Situs, TASKING, and Topological Autorouting and their respective logos are trademarks or registered trademarks of Altium Limited or its subsidiaries. All other registered or unregistered trademarks referenced herein are the property of their respective owners and no trademark rights to the same are claimed. v8.0 31/3/08.